= LATTICE

Release Notes for
Lattice Diamond 3.9.1

Welcome to Lattice Diamond®, the complete design environment for Lattice
Semiconductor FPGAs. Lattice Diamond design software offers leading-edge
design and implementation tools optimized for cost-sensitive, low-power
Lattice FPGA architectures.

Diamond is available for both the Windows and Linux operating systems. For
details, see “System Requirements” on page 8.

This version of Diamond adds a variety of enhancements to make designing
for Lattice Semiconductor programmable devices easier than ever. The
design tools also include support for the latest Lattice Semiconductor devices.
See “What’s New in Diamond 3.9.1” on page 2.

Lattice Semiconductor offers a rich variety of information sources, including
the Help system, PDF manuals, tutorials, and online discussions. The easiest
way to reach them all is through the online Help. The first topic in the Help
provides links to all the other sources of information.

You can also find extensive information about Diamond and its capabilities,
tools, and workflow on the Lattice Semiconductor website under:

www.latticesemi.com/latticediamond
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What's New in Diamond 3.9.1

What’s New in Diamond 3.9.1

This SP1 release of Diamond provides the following updates.

ECP5UM5G Updates

The VCC core voltage has been changed to 1.2 V (with +/- 5%) from 1.1 V
(with +/- 3%) SERDES settings has been updated.

SERDES settings updated.

ECP5UM/UM5G Updates

SERDES Tuning - the PLL_LOL_SET parameter default has been
changed to 0 and allows LDR change for all protocols.

CrossLink Updates
LVCMOS33/25 - I/0s now support 300 MHz frequency.

MachXO3L/LF 9400C/E Updates

A new Thermal Analysis process in Diamond software has been added to
calculate the maximum safe ambient temperature.

What’s New in Diamond 3.9

This release of Diamond provides a variety of new features.

CrossLink Family Support - Power Calculator enhancements for more
precise data for both normal and sleep mode operations

ECP5UM5G Family Support
Soft Error Injection (SEI) and LatticeMico support.

SERDES parameters tuning for optimal performance.

ECP5U/UM Family Support
ECP5U-12K plus ASC, ECP5UM-25K/45K plus ASC device support

SERDES parameters tuning for optimal performance.

MachXO02 Family Support - MachXO2HE devices with ASC device are
generally available.

MachXO3LF Family Support
MachXO3LF packages with ASC device is generally available.

Package, Timing, SSO and IBIS hardware data files are in final status

MachXO3L/LF & MachXO2 - INBUF support - All input buffers of unused PIO
and used outputs are disabled to save power when INBUF is set to OFF
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Supported Devices

Deployment Tool - Support added for STAPL file generation for ASC
devices.

Diamond Programmer - Macronix SPI flash device support added to
Diamond Programmer.

LatticeMico - Starting from Diamond 3.9, the LatticeMico installer will be
starting from version 1.0 and remain until updates are made to LatticeMico

Supported Devices

Lattice Diamond can be used with either a free license or a subscription
license. The two licenses provide access to different device families.

Device Family Free License Subscription License
ASC

ECP5U

ECP5UM
ECP5UM5G
LatticeEC™
LatticeECP™
LatticeECP2™
LatticeECP2M™
LatticeECP2S
LatticeECP2MS
LatticeECP3™
LatticeSC™
LatticeSCM™
LatticeXP™
LatticeXp2™
LIFMD (CrossLink)
MachXo™
MachXx0O2™
MachXO3L
MachXO3LF
Platform Manager™

Platform Manager 2
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Updating Projects from an Earlier Version

Updating Projects from an Earlier Version

If you want to work on a design project created with an earlier version of
Diamond, start with the following procedures. These procedures adapt the
project for the changes in Diamond.

Find out which version of Diamond your project was created with. Then work
through the changes for that and every later version, starting with the earliest
and going to the most recent. For example, if your project was created with
Diamond 1.1, you would start with the changes for 1.1. After completing those
changes, you would work on the changes for 1.2, then 1.4, and so on.

When you open a project from Diamond 1.2 or earlier, Diamond opens a
dialog box warning that Diamond will automatically move all SDC files to the
Synthesis Constraint Files folder in File List view and remove the “Input SDC
Constraint File” options from the strategies. If the project is using LSE, the file
names will be changed to use an .ldc extension.

Once saved, the project will not be compatible with earlier Diamond versions.

2.2 Projects

ECPS5 does not use the CIN port of the CCU2C Carry Chain primitive. This
port should not be connected to anything. If the port is connected, the Design
Map stage will fail with an error message. If you see such a failure, correct the
design in one of the following ways:

Rerun synthesis. This should correct the problem if the CCU2C primitive
is part of an IPexpress module.

If the CCU2C primitive was added to your HDL manually, edit the code to
remove the connection. See the following examples:

In Verilog:

CCU2C addsub_0 (.AO(scuba_vlo), -Al(DataA[0]),
.BO(scuba_vlo), .Bl(DataB[0]), .CO(scuba_vhi),
.Cl(scuba_vhi), .DO(scuba_vhi), .D1l(scuba_vhi),
.CINQ, -S0Q), -S1(Result[0]), .COUT(co0));

In VHDL.:

signal tmp: std_logic := "X";

cnt_cia: CCU2C
generic map (INJECT1_1=> *NO", INJECT1_0=> "NO",
INIT1=> X"0000", INITO=> X"0000"™)
port map (AO=>scuba_vhi, Al=>scuba_vhi, BO=>scuba_vhi,
Bl=>scuba_vhi, CO=>scuba_vhi, Cl=>scuba vhi,
DO=>scuba_vhi, Dl1=>scuba_vhi,
CIN=>tmp, SO=>open,Sl=>open, COUT=>cnt_ci);
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Updating Projects from an Earlier Version

2.0.1 Projects

Several strategy options have new default values. If you are using Synplify
Pro in integrated mode (running synthesis automatically in Diamond), check
that the following settings are still as you want them. Also, check the setting of
the Auto Hold-Time Correction option under Place & Route Design. Its default
changed to On for all devices. This is still current in Synplify Pro versions.

Table 1: New Default Values for Synplify Pro for Lattice

Option Before Now
Fanout Limit is now Fanout 100 1000
Guide

Export Diamond Settings to  Not available No

Synplify Pro GUI (new in 2.2)

Fix Gated Clocks and Fix 3 (converts and reports all True (converts with no
Generated Clocks combined sequential elements) report)
into new Clock Conversion

Frequency 200 auto (blank means “auto”)
Number of Critical Paths 3 blank (unspecified)
Number of Start/End Points 0 blank (unspecified)
Output Preference File False True

Pipelining and Retiming False Pipelining Only

Resolved Mixed Drivers True False

Use Clock Period for True False

Unconstrained I/O

1.4 Projects

For Diamond 1.4 and earlier, there might be some constraints that are not
honored because of the Synplify Pro cross-probing feature. This EDIF
renaming is usually related to bus names.

If such a problem occurs, you can turn off the renaming feature by placing the
following line in the “Command line Options” text box of the Synplify Pro
section of the active strategy:

set_option -syn_edif_array_rename 0
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Updating Projects from an Earlier Version

1.2 Projects

There were several enhancements for IP and MachXO2.

IP Incompatibilities

SPI14.2 2.7 is not compatible with Diamond 1.3 or later. If you are using this IP,
check the Lattice Semiconductor Web site for a more recent version.

MachXO2 Changes

See if your design involves any of the following features:
For EFB modules with user flash memory (UFM), regenerate the module.

For I0_TYPE=PCI33 on a MachX02-1200 or larger device, check if the
CLAMP is using the default setting. With Diamond 1.3 the CLAMP default
changes from ON to PCI and the 1/0O will be placed in bank 2. If you were
using the default and still want the setting to be ON, you need to set it
explicitly.

For PCI33 MT 6.5 and PCI33 T 6.4 IP, either set the CLAMP to ON
explicitly or choose a bigger package (256 or more).

1.1 or 1.0 Projects

There were several enhancements for IP and MachXO2.

IP Incompatibilities

The following IP versions are not compatible with Diamond 1.2 or later. If you
are using any of these IP, check the Lattice Semiconductor Web site for a
more recent version.

Convolution Block Encoder 3.6 Interleaver Deinterleaver 3.5
DDR1 6.9 PCI_MT_336.4

DDR2 7.1 PCle RC Lite 1.2
DDR31.2.1 Tri-Speed MAC 3.4
DDR1_CP 1.1 with MachX02 Viterbi Block Decoder 4.6

DDR2_CP 1.1 with MachX02

ECP5 Support

For ECP5U and ECP5UM designs, for better EBR and SERDES tuning and
DSP/Distributed RAM control for constant process, it is a necessity to
recompile your design using the current release of Diamond.
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Migrating ispLEVER Projects

MachXO2 Support

Some aspects of the software support for MachXO2 designs have been
improved. See if your design involves any of the following features:

The 4K/7K design with PLL has a CIB-to-PLL jump change. If you are
using this design, recompile it.

The EFB simulation model has changed. If you are using the EFB module,
rerun your simulation tests to see more accurate results.

In the DDR_GENERIC module of IPexpress, the GDDRX1_RX.Aligned
with PLL interface is no longer supported. If you are using such a module,
use IPexpress to regenerate it without the PLL option.

Also, MachXO2 has IP evaluation capability and TransFR mode for all 1/Os.

Migrating ispLEVER Projects

Diamond uses a different project structure than ispLEVER and cannot directly
open an ispLEVER project. However, design projects created in ispLEVER
can easily be imported into Diamond. The process is automatic except for the
ispLEVER process properties, which are similar to the Diamond strategy
settings, and some modules and IPs. All of your ispLEVER project source will
be automatically handled.

Projects created using ispLEVER can be imported into Lattice Diamond
through two different paths:

On the Start Page, click Import ispLEVER Project (in the upper-left
corner).

From the File menu, choose Open > Import ispLEVER Project.

Follow the directions in the dialog box that opens to convert your ispLEVER
project into a Lattice Diamond project.

Limitations to the import/conversion process include:

NGO files in ispLEVER projects need to be manually copied into the
Lattice Diamond project if the NGO files were originally copied into the
ispLEVER project. For example, NGO files that were copied from Lattice
IP generation.

The .Ipc files are replaced with .ipx files in Lattice Diamond. You need to
regenerate your IP by double-clicking on the .Ipc file. The resultant wizard
will help you generate the new .ipx file, replacing the old .Ipc file.

More information on importing ispLEVER projects can be found in the Lattice
Diamond User Guide, online Help (see Managing Projects > Importing
ispLEVER Projects), and training videos on the Lattice Web site.
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Other Information Resources

Other Information Resources

Other available information resources for the Diamond software include the
following.

General Information: General information on Lattice Diamond can be
found on the Lattice Web site at:

www.latticesemi.com/latticediamond

Online Help: Start Lattice Diamond and choose Help > Lattice Diamond
Help.

Lattice Diamond User Guide: This document can be found from a link on
the Start Page view.

Training Videos: Several short videos are available on different aspects of
the Lattice Diamond software. These can be viewed online at:

www.latticesemi.com/latticediamond
Click the Videos tab.

System Requirements
The basic system requirements for Lattice Diamond are:

Intel Pentium or Pentium-compatible PC, or AMD Opteron system support
(Linux only)

CPU with the SSE3 instruction set to run the Aldec Active-HDL Lattice
Edition simulator

One of the following operating systems:

Windows Vista (32-bit), Windows 7 (32-bit or 64-bit), Windows 8 (32-
bit or 64-bit, including Windows 8.1), or Windows 10 (32-bit or 64-bit).

Red Hat Enterprise Linux 4, 5, 6 or 7.0. The host operating system is
supported in 64-bit only. (Note: Red Hat operating systems above
v7.0 are not supported.)

Version 5.3 of Red Hat Enterprise Linux has some extra installation
requirements. See “Configuring Red Hat 5.3” on page 10.

Approximately 5.75 GB free disk space

RAM adequate for your FPGA design. For guidelines see “Memory
Requirements” on page 9.

Network adapter and, for a floating license, network connectivity

A node-locked license is based on the physical (hard-coded) address
provided by the network adapter. Network connectivity is not required for a
node-locked license. In the absence of a network connection, you can
install the NWLink IPX/SPX protocol to force recognition of your NIC card
ID (see the Installation Notice).

A floating license requires access to the license server, so both a network
adapter and connectivity are required.
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System Requirements

JavaScript-capable Web browser

Microsoft Internet Explorer 8 or higher if using the included Aldec Active-
HDL Lattice Edition simulator

Acrobat Reader 5.0 or later

Memory Requirements

Table 2 lists the minimum memory requirements and the recommended
memory for the Lattice Semiconductor devices supported by Diamond.

On Windows, designing for the largest FPGAs may require more than the
usual 2 GB of memory found in 32-bit computers. For help in extending your
memory to 3 GB, see “Extending Memory on Windows” on page 10.
Designing for LatticeECP3 with more than 95K LUT on a Windows system
requires a 64-bit operating system.

Table 2: Recommended Memory

Device

ECP5U/UM/UM5G

LatticeEC, LatticeECP

LatticeECP2/M

LatticeECP3

LatticeSC/M

LatticeXP, LatticeXP2

MachXO, MachX02,
MachXO3L

LIFMD (CrossLink)

Platform Manager,
Platform Manager 2

Size 32-Bit Operating Systems 64-Bit Operating Systems

Minimum Recommended Minimum Recommended

All 2GB 3GB 4GB 6 GB
Up to 20K LUT 512 MB 768 MB 1GB 15GB
Up to 50K LUT 768 MB 1GB 1.5GB 2GB
Up to 20K LUT 768 MB 1GB 1.5GB 2GB
Up to SOK LUT 1GB 15GB 2GB 3GB
Upto 100K LUT 1GB 2GB 2GB 4 GB
Up to 95K LUT 2GB 3GB 4GB 6 GB
Upto 150K LUT 3 GB 4GB 6 GB 8 GB
Up to 40K LUT 768 MB 1GB 15GB 2GB
Upto 115K LUT 1 GB 25GB 2GB 5GB
Up to 20K LUT 512 MB 768 MB 1GB 15GB
Up to SOK LUT 768 MB 1GB 15GB 2GB
All 256 MB 512 MB 512 MB 1GB
All 256 MB 512 MB 512 MB 1GB
All 256 MB 512 MB 512 MB 1GB
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Issues Fixed

Issues Fixed

Extending Memory on Windows

Designing for LatticeECP3 or ECP5 may require more than the 2 GB normally
available with 32-bit Windows systems. But you can configure Windows to
use up to 3 GB of memory.

Note that increasing the amount of memory available to applications
decreases the amount available for the file cache, paged pool, and nonpaged
pool, which can affect applications with heavy networking or 1/O.

Use the BCDEdit /set increaseuserva 3072 command to set the boot
entry option to 3 GB. For details, see Microsoft article “BCDEdit /set”:
msdn.microsoft.com/en-us/library/ff542202.aspx

Configuring Red Hat 5.3

Red Hat Enterprise Linux 5.3 has some extra requirements for Diamond:

In addition to the basic installation of Red Hat 5.3, under Development/
Legacy Software Development, select:

1:gtk+-1.2.10-56.e15.i386 - GIMP Toolkit (GTK+) sb:(9 of 9)

Under Base System/Legacy Software Support, add the following to the
default items:

Openmotif22-2.2.3-18.1386 - Open Motif runtime
Proper Diamond operation depends upon these libraries being installed.

When installing the Red Hat Enterprise Linux version, be sure to install the
PERL modules XML::Parser, XML::DOM, and XML::RegExp. These
PERL modules are available at www.cpan.org.

The following known issues are fixed with this release. Their workarounds are
no longer needed. For the complete list of known issues, see
www.latticesemi.com/view _document?document_id=50676

PAR Fails when Master SPI Port enabled

Specifically for the MachXO3L/LF-9400 device, PAR was failing when the
master SPI Port was enabled.

Versions affected: Diamond 3.9
Devices affected: MachXO3L
Fixed_3.9.1

CR127767
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Issues Fixed

Effective Theta-JA value fixed for MachX02-640HC
QFN48 package

Formerly the Theta-JA value in the Power Calculator tool was missing when
the MachX02-640HC QFN48 family and package was selected.

Versions affected: Diamond 3.8/3.9
Devices affected: MachXO2

Fixed 3.9.1

CR127620

Large deviation in power calculation for LatticeXP2

using older Diamond v2.2

Between Diamond v2.2 and Diamond v3.8, the power calculated using Power
Calculator had a difference greater than 20%.

Versions affected: Diamond 3.8/3.9
Devices affected: LatticeXP2

Fixed _3.9.1

CR127606

CrossLink LVCMOS3.3 IO may report error that
design does not meet 300 MHz requirement for

pixel clock port

The CrossLInk datasheet recently increased the LVCMOS33 10’s fMAX from
250 MHz to 300 MHz. Diamond v3.9 timing models have not been updated to
support this increase. If the user has a timing constraint for a LVCMOS33 10
running higher than 250 MHz, a timing violation will be reported by the timing
analysis tool.

Versions affected: Diamond 3.9.1
Devices affected: CrossLink
CR127535

Deployment Tool crashes when generating

CrossLink bitstream file
Generating a JED file causes a crash to the Deployment Tool.

Versions affected: Diamond 3.9
Devices affected: CrossLink
Fixed_3.9

CR127403
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Known Issues

Known Issues

SPI Flash Programming issues when using RHEL

7.2 OIS

When programming the SPI Flash on a LatticeECP5 Versa board, the
operation is stuck in the verifying stage when using RHEL 7.2.

Versions affected: Diamond 3.9
Devices affected: ECP5UM
Fixed_3.9

CR127391

Quad SPI configuration does not function for
ECP5UM using Spansion Flash FL164KIF01

The Quad I/O capable SPI flash from Spansion is a supported flash, but is not
configured by the Programmer for Quad 1/0 boot.

Versions affected: Diamond 3.9
Devices affected: ECP5UM
Fixed 3.9

CR126436

Following are known issues with this release and workarounds for them. For
the complete list, see:
www.latticesemi.com/view_document?document_id=50676

Thermal Analysis Headers need Units

The degree Celsius units are showing strange characters in the Thermal
Analysis Report for some of the headers such as Theta-JA, Total Power and
Maximum Safe Ambient. The calculated values are correct though.

Versions affected: Diamond 3.9.1
Devices affected: MachXO3L/LF9400
CR127798
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Known Issues

MachXO3 Platform Designer does not set default
frequency for Power Calculator

Versions affected: Diamond 3.9.1
Devices affected: MachXO3LF + ASC
CR127761

When an existing design is opened or when creating a new XO3 Platform
Designer project, the ‘Generate JEDEC’ will result in an error:

ERROR - Clock frequency cannot be 0. Please set Default Clock Frequency
in thermal analysis of Strategy.

Done: error code 1

The workaround is to select the File List view -> in Active Strategy -> Edit and
click on Thermal Analysis in the process window -> Edit the ‘Default Clock
Frequency to a value of 8 MHz.

Versions affected: Diamond 3.9.1
Devices affected: MachXO3LF + ASC
CR127761

Synplify replicates certain control signals for
timing improvement, which causes MAP failure
(LatticeECP3)

A workaround is to put a syn_keep attribute on the CE (clock enable) signal.
This defect is acknowledged by the vendor Synopsys which will provide a fix
by the next release of Diamond.

Versions affected: Diamond 3.9
Devices affected: LatticeECP3
CR127002

IPs CPRI v5.2 (LatticeECP3) and Tri-Speed Ethernet
MAC v4.1 (LatticeXP2) cause errors during

synthesis

When synthesizing the above IPs with Synplify or LSE, a user may run into
semantic errors in some IPs including the above such as unqualified net
names which may causes preferences to not be called. Such semantics must
be manually fixed until an updated packaged version of the IP is released.

Versions affected: Diamond 3.9
Devices affected: LatticeECP3, LatticeXP2
CR124134
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Known Issues

Lattice Synthesis Engine (LSE) may have lower

fMAX on synthesis of IPs

Some IPs in Diamond are optimized for Synplify and hence the fMAX
performance with LSE may be lower. Use Synplify as workaround.

Versions affected: Diamond 3.9
Devices affected: All

FSM Gray encoding may cause issues with LSE
Synthesis

When synthesizing gray encoding style with LSE synthesis tool, an incorrect
state may be transitioned. To work around the issue a user can change the
active strategy as follows:

1. In Diamond, choose Project > Active Strategy > LSE Settings.

2. Inthe Strategies dialog box, set FSM Encoding Style value to Binary.

Versions affected: Diamond 3.9
Devices affected: All
CR127472

Some Intellectual Property (IP) modules may not
meet targeted timing on LatticeECP3 or LatticeXP2

devices

Some IP modules may not meet targeted fMAX when used with LatticeECP3
or LatticeXP2 devices. The following table lists the IP and affected devices:

P LatticeECP3 LatticeXP2
2.5G Ethernet PCS

JESD207

PCI Master Target 66

PCI Target 66

PCS PIPE

SRIO

DDR2 SDRAM Controller

If you need assistance with this issue, contact Lattice Technical Support.

Versions affected: Diamond 3.9
Devices affected: LatticeECP3, LatticeXP2
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Contacting Technical Support

Contacting Technical Support

FAQs The first place to look. The Answer Database on the Lattice
Semiconductor Web site provides solutions to questions that many of our
customers have already asked. Lattice Applications Engineers are
continuously adding to the Database.

Technical Support Assistance Submit a technical support case via
www.latticesemi.com/techsupport.

For Local Support Contact your nearest Lattice Sales Office

Trademarks

All Lattice trademarks are as listed at www.latticesemi.com/legal. Synopsys and Synplify Pro are trademarks of
Synopsys, Inc. Aldec and Active-HDL are trademarks of Aldec, Inc. All other trademarks are the property of their
respective owners.
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